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Menu Commands
File Menu

New 
Open 
Close 
Save 
Save As 
Print 
Print Picture Catalog... 
Print Setup... 
Print Alignment 
Preferences sound 
Preferences workspace 
Preferences album 
Free Fonts and Graphics... 
Network Licence 
Exit 

Edit Menu

Undo 
Redo 
Cut 
Copy 
Paste 
Delete 
Duplicate 
Select All 
Group 
Ungroup 

View Menu

Toolbar 
Status Bar 
Sidebar 
Format Bar 
Fill-in Fields 
Address Book 
Per cent View 
Fit in Window 
Fit to Window Width 
Fit to Window Height 
Zoom In 
Zoom Out 
Zoom to Area 

Card Menu

View Card 
Edit Front 
Edit Inside 
Edit Back 



Background Menu

New Background... 
Colour... 
Attributes... 
Remove Background 
Mirror left to right 
Flip top to bottom 

Calendar Menu

Month and Year... 
Calendar Style... 
Edit Calendar Title 
Date Number Font... 
Weekday Name Font... 
Edit Date Text 
Choose Date Picture... 
Date Picture Colour... 
Date Picture Attributes... 
Clear Date 

Pictures Menu

Select Pictures... 
Add a New Picture 
Add a New Shape 
Position 
Layer 
Colour 
Attributes 
Replace Picture... 
Mirror left to right 
Flip top to bottom 

Text Menu

Select Text... 
Add a New Text Box 
Add a New Title Text Box 
Position 
Layer 
Edit Text 
Mirror left to right 
Flip top to bottom 
Choose font... 
Stretching 
Horizontal Alignment 
Vertical Alignment 
Fill-in Fields

Window Menu

Cascade 
Tile 
Arrange Icons 
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Help Menu

Index 
Using Help 
About PMW... 



New
Use this command to create a new project in the PrintMaster Gold Publishing Suite.

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab displayed on the Project 
Album. To start your own project, click the Make Your Own project button. 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open.

Shortcuts

Toolbar:
Keys: CTRL+N



Open
Use this menu command to open an existing project.

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab displayed on the Project 
Album. Click on the project thumbnail with your mouse to select, then click the Open button.

To start your own project, click the Make Your Own project button or choose File, New.

Shortcuts

Toolbar:
Keys: CTRL+O



Print Picture Catalog...
Use this command to print out some or all of the pictures that are available for you projects. Highlight the 
desired pictures with your mouse and click on the Print button.

Number Per Page



Print Setup...
Use this command to select a printer and a printer connection.

Select the printer you want to use; only installed printers appear. You install printers and configure ports 
through the Windows Control Panel. For information on installing printers, see your Windows 
documentation.



Free Fonts and Graphics...

Register your PrintMaster Gold Publishing Suite to enjoy more of the exceptional quality fonts and 
graphics offered by Mindscape International    for FREE!

For your convenience, you can register by Phone or simply complete and return the Registration Card 
attached to the inside back cover of your PrintMaster Gold Publishing Suite User's Guide.

Enter the registration code you receive for registering your PrintMaster Gold software in order to enable 
69 additional fonts and 63 additional graphics.

3 Great Reasons to Register



Network Licence

Single User Licence
Mindscape International, as Licensor, grants only to you, the Licensee, a nonexclusive right to use the 
enclosed software on one single computer (CPU) at one single location.

You may not install this software on networks, sublicence, loan, rent, or otherwise distribute this software 
for use by others. You may be held legally responsible for any copyright infringement that is caused or 
encouraged by your failure to abide by the terms of this licence.



Exit
Use this command to end your PrintMaster Gold session. PrintMaster Gold will prompt you to save 
documents that contain unsaved changes.

You can also exit a project by choosing File,Close.

Shortcuts
Sidebar: Click the Exit button located on the Sidebar.
Keys: ALT+F4



Toolbar
The Toolbar is displayed across the top of the PrintMaster Gold window and provides quick mouse access
to some of the most common commands in PrintMaster Gold, such as File Open.

To hide or display the Toolbar, click on the Toolbar item located in the View menu.



Status Bar
The Status Bar is displayed at the bottom of the PrintMaster Gold window. The left side describes the 
actions of menu items as you use the arrow keys to navigate through the menus. This area similarly 
shows messages that describe the actions of Toolbar buttons as you depress them.

The right side of the Status Bar indicates keyboard status.

To hide or display the Status Bar, click on the Status Bar item located in the View menu.



Sidebar
The Sidebar is displayed on the left-hand side of the PrintMaster Gold window and lists project features 
and design options. When projects, pictures, page layouts, and text are displayed, the Sidebar identifies 
the current activity choices such as Select Picture, Edit Text, etc.

To hide or display the Sidebar, click on the Sidebar item located in the View menu.



Fit in Window
Use this command to adjust the layout view to fit your project page.

Choose Fit in Window from the View menu.



Fit to Window Width
Use this command to adjust the layout view to fit the page width of your project.

Choose Fit to Window Width from the View menu.



Fit to Window Height
Use this command to adjust the layout view to fit the page height of your project.

Choose Fit to Window Height from the View menu.



Cut
Use this command to remove the currently selected (highlighted) text or picture from the project page and
put it on the clipboard. This command is unavailable if there is no text or picture currently selected.

Cutting text or pictures to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy
Use this command to copy selected (highlighted) text or picture onto the clipboard. This command is 
unavailable if there is no text or picture currently selected.

Copying text or pictures to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste
Use this command to insert a copy of the clipboard contents at the insertion point. This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Delete
Use this command to remove a selected object (e.g. text box, picture, etc.) from the project page.

Shortcuts
Keys: DEL



Duplicate
Use this command to make a quick and easy copy of a selected text box or picture. You can make a 
single copy or multiple copies arranged into a group.



Select All
Use this command to select all objects (e.g. text boxes, pictures, etc.) on the project page.

Note that Backgrounds cannot be selected using    this feature.



Group
Sometimes you will have a combination of text boxes and pictures that need to remain positioned relative 
to each other. The Grouping option makes it easy for you to manage multiple text boxes and pictures that 
are related by combining them in a single group. In this way, you can flip, duplicate, and move all of them 
at the same time.

Use your mouse to select the text boxes and pictures you want to group together, then select Group from 
the Edit menu.

Select Ungroup to break up a group into individual text boxes and pictures to be manipulated separately.



Ungroup
Use this command to ungroup objects that have been grouped together. See Group.



New Background...
This option allows you to select fancy Backgrounds and Borders that add style to your projects. 

Choose a category from the Picture Album by clicking on its tab. To add a new picture to your project 
page, simply double-click on its thumbnail with your mouse.

Note: Unlike other pictures added to your project page using the Select Pictures... command, Background
pictures cannot be resized or layered.



Remove Background
This option removes the current background or border from the project page. To add a new Background 
to your project, select the New Background... command.



Select Pictures...
Use the Select Pictures command to add a new picture, or remove an existing picture from your project 
page. See also Add a New Picture.

Choose a category from the Picture Album by clicking on its tab. To add a new picture to your project 
page, simply double-click on its thumbnail with your mouse.

Clicking Remove in the Select Pictures dialog will remove the currently highlighted picture from your 
project.



Layer
Text box and picture elements in a PrintMaster Gold project are like a deck of playing cards, each element
has its own position or layer in the deck and each element can hide the elements under it, or be hidden by
the elements above. PrintMaster allows you to "shuffle" the layering order of your text boxes and pictures 
to move selected elements in front of or behind others. Individual text boxes can be placed in front, back, 
or anywhere in between.

Backgrounds are always in the backmost layer. Text boxes and pictures cannot be moved behind a 
background.

Bring to Front moves the selected text box or picture to the first layer, in front of all other text boxes and 
pictures.

Forward One Layer moves the selected text box or picture forward a layer.

Back One Layer moves the selected text box or picture back a layer.

Send to Back moves the selected text box or picture to the last layer, in back of all other text boxes and 
pictures (except a background).

Any Layer options that do not apply to the selected text box or picture will be "greyed out".



Colour

Use this command to change the colour of the selected text, background, border, or picture.

Use the up or down arrow to scroll through the list of available colours. Samples of highlighted colours will
be displayed to the right.

Press Enter or click OK to confirm your selection.

More Colours...



Attributes
The Render Method and Colouring Book options can be selected in this dialog. Some options may not be 
available for certain types of pictures in which case they will be "greyed out". In general, the Render 
Method option applies to pictures, backgrounds, or borders in a bitmapped format such as TIF or PCX.

The colouring book option is available for pictures in the CGM format. This includes some of the pictures, 
backgrounds, or borders that come with PrintMaster Gold.



Mirror left to right
Use this command to flip any text box, picture, or background horizontally.

Repeat this command to restore an object to its original position.

Shortcuts

Format Bar:



Flip top to bottom
Use this command to flip any text box, picture, or background vertically.

Repeat this command to restore an object to its original position.

Shortcuts

Format Bar:



Add a New Picture
Use this command to select a new picture to be placed on your project page.

Choose a category from the Picture Album by clicking on its tab. To add a new picture to your project 
page, simply double-click on its thumbnail with your mouse.

Clicking Remove in the Select Pictures dialog will remove the currently highlighted picture from your 
project.

See also Picture Rotation

Shortcuts

Toolbar:  



Select Text...
Use this command to add a new text box, or remove an existing text box from your project page. See also
Add a New Text Box.

The list box displays text samples associated with each of the text boxes currently being used in your 
project.

Select a text box by clicking on the associated sample text. The selected text box appears as an outline 
(in the project layout area) around all of the text it contains. Confirm your choice by clicking OK.

Clicking Remove in the Select Text dialog will remove the text box (from your project) associated with the 
currently highlighted sample text.



Add a New Text Box
Use this command to create and select an empty text box that will be placed in the middle of your project 
layout area.

Clicking Remove in the Select Text dialog will remove the text box (from your project) associated with the 
currently highlighted sample text.

Shortcuts

Toolbar:  



Position
Use this command to move (and size) a text box or picture to a standard or custom defined position.

The following positioning options are available:

Standard allows you to select a text box or picture position and size from a pre-defined list of choices. 
Select a position by clicking on its name. A preview of the select position will appear to the right of the 
dialog.

Position lets you set the horizontal and vertical positioning independent of each other. Choose a 
standard position or type in a specific numeric value. See also Type in Position 

Size lets you set the horizontal and vertical size independent of each other. Choose a standard size or 
type in a specific numeric value. See also Type in Size 

Note: Click the Reset button to return a modified text box or picture to its last size and position on your 
project page.

Shortcuts

Format Bar:



Edit Text
The fastest way to edit a specific section of text is to simply double-click on it. A cursor will appear within 
the selected text at the position indicated by your mouse and the Edit Text sidebar will be activated with a 
variety of options for changing the font attributes and text formatting.

You can also select the Type and Edit Text option from the Text Box sidebar.



Choose font
PrintMaster Gold lets you change the attributes on a character-by-character basis of any selected text 
with your choice of fonts, sizes, styles, colours, and special effects.

Font
Use this option to choose the font you want applied to the currently selected text. A sample of each 
selected font is displayed on the right side of the font menu.

Shortcuts

Format Bar:  

Size
Use this option to choose the size you want applied to the currently selected text.

Shortcuts

Format Bar:  

Style
Use this option to choose the style you want applied to the currently selected text. Select either 
Normal, Bold, Italic, or Bold Italic. A sample of the highlighted style will be displayed on the right 
side of the font dialog box. Style Note.

Shortcuts

Format Bar:  

 

Pattern
Use this option to choose the pattern you want applied to the currently selected text. A sample of each
selected pattern is displayed on the right side of the font menu. Pattern Tip.

Outline
Use this option to choose the outline you want applied to the currently selected text. A sample of each
selected outline is displayed on the right side of the font menu.

Shadow
Use this option to choose the shadow you want applied to the currently selected text. A sample of 
each selected shadow is displayed on the right side of the font menu.

Colour
Use this option to choose the colour you want applied to the currently selected text. See Colour.



Stretching
The Stretching command automatically adjusts the text size to fill the limits of a text box.

Shortcuts

Format Bar:  



Horizontal Alignment
Use this command to control the horizontal alignment of all text within a text box.

Select one of the following options:

Left Aligned
Centered Aligned
Right Aligned

Shortcuts

Format Bar:  

 

 



Vertical Alignment
Use this command to control the vertical alignment of all text within a text box.

Select one of the following options:

Top Aligned
Middle Aligned
Bottom Aligned

Shortcuts

Format Bar:  

 

 



Per cent View
This option allows you to increase or decrease the layout view level by fixed percentages.

Choose Per cent View from the View menu.

Select one of the following options:

25% View
50% View
100% View
200% View
400% View



Cascade
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Arrange Icons
Use this command to arrange the icons for minimised windows at the bottom of the main window. If there 
is an open project window at the bottom of the main window, then some or all of the icons may not be 
visible because they will be underneath this project window.



Index
Use this command to display the opening screen of Help. From the opening screen, you can jump to step-
by-step instructions for using PrintMaster Gold and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help
Use this command for instructions about using Help.



About PMW...
Use this command to display the copyright notice and version number of your copy of the PrintMaster 
Gold Publishing Suite.



Close
Use this command to close all windows containing active projects. PrintMaster Gold suggests that you 
save changes to your project before you close it. If you close a project without saving, you lose all 
changes made since the last time you saved it.

Before closing an untitled document, PrintMaster Gold displays the Save Project dialog box and suggests 
that you name and save the document.



Save
Use this command to save the active project to its current name and directory. When you save a project 
for the first time, PrintMaster Gold displays the Save Project dialog box so you can name your document. 
If you want to change the name and directory of an existing document before you save it, choose the 
Save As command.

If you are saving a project for the first time, the following will be available:

File Name
This option lets you type in a unique filename for your project.

Category
This item lists the category on the Project Album to which your project will be saved. To save your 
project to a different category, pull down the Category menu and select the desired one from the list.

Project Description
This item lets you attach a short description to your project.

Directory
This item displays the default drive and directory to which your project will be saved. To specify a 
different drive or directory, click the Change... button.

The Save Project dialog also gives you the ability to Save Picture Files in Project.

Shortcuts

Toolbar:
Sidebar: Click the Save Project button located on the Sidebar.

Keys: CTRL+S



Save As
Use this menu command to save and name the active document. PrintMaster Gold displays the Save 
Project dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.

The following options allow you to specify the name and location of the project you are about to save:

File Name
This option lets you type in a unique filename for your project.

Category
This item lists the category on the Project Album to which your project will be saved. To save your 
project to a different category, pull down the Category menu and select the desired one from the list.

Project Description
This item lets you attach a short description to your project.

Directory
This item displays the default drive and directory to which your project will be saved. To specify a 
different drive or directory, click the Change... button.

The Save Project dialog also gives you the ability to Save Picture Files in Project.



Print
Use this command to print your finished projects.

The Print dialog allows you to easily choose and configure your Windows printer, select the output size 
and print options for your project, and set number of copies to print.

Printer
The name and port of the selected Windows printer is displayed next to this item. Click the Setup button 
to change printers and options. See Printer Setup.

PrintMaster performs full 24-bit rendering of pictures before sending the data to the printer. If the selected 
Windows printer driver has its own options for dithering or rendering pictures, pick the option which best 
describes simple monochrome data (e.g., Line Art). In addition, any intensity controls supported by the 
driver will probably have no effect on the output from PrintMaster Gold.

See also:

Print Quality 
Fill-in Fields
Output Size 
Which Tiles... 
Colouring Book 
Smoothing 
Advanced... 
Copies 
Starting Label 
Starting Card 
Envelope Feed 

Shortcuts

Toolbar:
Sidebar: Click the Print Project button located on the Sidebar.
Keys: CTRL+P



1, 2, ...
PrintMaster Gold displays a list of currently open project windows at the bottom of the Window menu. A 
check mark appears in front of the project name of the active window. Choose a project from this list to 
make its window active.    



Screen Layout

The Layout Area displays your project as you compose and edit it. Use the arrows keys and your mouse 
to position text and pictures within the Layout Area.



Mouse and Keyboard Conventions
PrintMaster Gold supports the standard Microsoft Windows mouse and keyboard command conventions. 
Use your mouse and the following keys to select menu items or to confirm PrintMaster Gold commands.

Use the up and down arrow keys to select (highlight) a desired item within the currently active menu.

TAB
Use this key to move to the next menu or command button.

SHIFT+TAB
Use this key combination to move to the previous menu or command button.

ESC
Use this key to return to a prior menu.

ENTER
Use this key to confirm the current selection or command.

ALT
Use this key in combination with the highlighted key of any menu name or command button to move 
directly to the menu or to immediately execute the button command. For example, press ALT+F to move 
to the File menu.

F1
Use this key to display help information about the current menu items.



Use Templates For A Fast Start

PrintMaster Gold comes with dozens of pre-made templates which you can quickly customize for your 
particular needs.

Before starting a project, check the list of existing templates and see if one of them is close to what you 
want. You can save a lot of time by making a few changes to an existing document instead of starting 
from scratch. As you create projects of your own, those saved documents will also become templates 
which can be easily changed and used for future occasions.

Working with PrintMaster Gold templates is also a great way to learn some of the advanced techniques 
such as shadowing and picture overlapping used by the designers at Mindscape International.





Creating a Poster

The Poster project can be used to create page-size Posters, Fliers, Bulletins, and Certificates - or Signs 
that cover an entire wall!

Beginning a Poster:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Poster:

Click the Make Your Own Poster button. Select either Tall or Wide for the Poster Size.

To open an existing Poster: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Poster selection.



The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Poster projects. Choose a design element by clicking on the 
corresponding sidebar button. After confirming your selection, the sidebar will display all of the options for 
editing the background, text, or picture design element you selected.



Creating a Card

The Card is one of PrintMaster Golds most versatile projects. Create invitations, holiday cards, programs, 
menus, or similar projects.

Beginning a Card:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Card:

Click the Make Your Own Card  button. Select either Tall or Wide for the Card Size. Next choose the 
position of the Card fold, pick either Top or Side.

To open an existing Card: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Card selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Card projects. Choose a design element by clicking on the 
corresponding sidebar button. After confirming your selection, the sidebar will display all of the options for 
editing the background, text, or picture design element you selected.



How To Fold A Card

With the printed side facing down, bring the top and bottom edges together and crease the fold. With the 
inside of the card facing you, bring the left edge to the right edge (so that the card front is now on top) and
crease the fold.



Creating a Banner

Nothing grabs attention like a PrintMaster Gold Banner! You can celebrate special occasions in style. Your
message will get across in a big way.

Beginning a Banner:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Banner:

Click the Make Your Own Banner button.

To open an existing Banner: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Banner selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create great looking Banners up to 100 feet long! Choose a design element by clicking on the 
corresponding sidebar button. After confirming your selection, the sidebar will display all the options for 
editing the text or picture design element you selected.



Creating a Calendar

With PrintMaster Gold you can design a Calendar to fit in your wallet or fill a bulletin board. Monthly and 
weekly Calendar styles are available and any day can be enhanced with both text and pictures.

Beginning a Calendar:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Calendar:

Click the Make Your Own Calendar button. Select either Tall or Wide for the Calendar Size.

Select the Calendar Type.

PrintMaster Gold supports three Calendar Types. Mark the type of Calendar you want to create.

Select the Calendar Date (Month, Year, and Week for Weekly Calendars.) Click the Now button to select 
todays date. PrintMaster Gold will automatically number each day of Monthly and Weekly Calendars.

To choose an existing Calendar:

Although saved Calendars are always configured for a specific date, you can easily load a saved 
Calendar, and change the Year, Month, or Week. PrintMaster Gold will automatically update your 
Calendar with the new date numbers.

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Card selection.



The Calendar Design Choices sidebar provides options for customizing your Calendar, saving it to disk, 
and printing it out. Choose a design option by clicking on the corresponding sidebar button.



Pictures

Nothing attracts a readers attention like a great picture. You can use pictures in your PrintMaster Gold 
documents to draw the readers attention to your message. PrintMaster Gold comes with hundreds of 
gorgeous clip-art images, perfect for every occasion. PLUS, PrintMaster Gold works with all popular 
graphics formats: PCX, WMF, TIF, GIF, CGM, and BMP; PrintMaster Gold even lets you use your own 
scanned images!

PrintMaster Gold makes it extremely easy to add pictures to your projects. You can have as many 
pictures as you like, and they can be resized, rotated, or arranged anywhere you want on the page. The 
pictures included with PrintMaster can be stretched and scaled up to 6 feet with no loss of detail.

PrintMaster displays your pictures on screen so you can easily tell what your page will look like when 
printed. When you select a picture to work on, PrintMaster places a frame around a picture to indicate its 
exact position and size. The dots located at the corners and in the middle of each frame edge are called 
handles. A picture must be selected before it can be resized, rotated, positioned, or otherwise edited.



Printing a Project

To print your project, proceed as follows:

1. Open your project in PrintMaster Gold.

2. Click the Print project (e.g., Print Poster, Print Card, etc.) button on the Design Choices sidebar.

3. Confirm that the current settings are correct.

4. Click Print to start the printing process.

See also Print

Shortcuts

Toolbar:
Sidebar: Click the Print Project button located on the Sidebar.
Keys: CTRL+P



Colouring Book

PrintMaster lets you print certain types of pictures as they would look in a colouring book: only the picture 
outline is printed and all colour fills are printed as white. The colouring book option can be set on a per 
picture basis. Select the Colouring Book option in the Print Dialog to override these individual settings as 
follows:

None turns off all colouring book printing regardless of the individual picture settings.

As Selected (the default) performs colouring book printing according to the individual picture settings.

All turns on colouring book printing for all appropriate pictures.

Only certain types of pictures can be printed with the colouring book feature. This includes all the pictures,
backgrounds and borders provided by PrintMaster and the Mindscape Clip Art Library, or any other 
picture in the CGM graphics format. For other formats such as TIF or PCX, the colouring book option will 
have no effect.



Saving a Project

Click the Save Project button in the sidebar menu.

If you are saving a new project, PrintMaster will prompt you to provide a file name. Type a unique name 
into the File Name box and click OK.

You may also attach a short description to your project.

If you want to save an existing project under a new name, then select the Save As... item under the File 
menu near the top of the screen. PrintMaster will prompt you for the new file name and description.

See also Save

Shortcuts

Toolbar:
Sidebar: Click the Save Project button located on the Sidebar.

Keys: CTRL+S



Render Method

Use Render Method to adjust the way PrintMaster combines coloured dots to simulate colour shading and
grey tones in bitmapped graphics. Most bitmapped graphics have more colours or greys than the output 
device (screen or printer) is capable of showing. PrintMaster Gold uses two methods to approximate 
those colours as well as possible on an output device. For example, consider an image with 256 colours 
on a printer that only supports 16 colours. PrintMaster makes the 256 colours appear by mixing the 16 
colours available. The general name for processing an image for screen or printer is "rendering".

The specific rendering methods available in PrintMaster Gold are Ordered Dither and Error Diffusion.



Ordered Dither
An Ordered Dither uses a fixed set of patterns to blend colours. Each colour or grey in the image changes
to a pattern of colours on the output device. The appearance of the resulting image is very regular.



Error Diffusion
Error Diffusion creates patterns "on-the-fly," and the resulting patterns tend to be more dense and unique. 
Images often look better with Error Diffusion, though the patterns look very unusual when viewed up 
close. Also, because Error Diffusion patterns are more dense, the image tends to darken due to bleeding 
of ink or toner when the image is printed. This means that if you use Error Diffusion, you will probably also
need to adjust your printer contrast to lighten the image.



Print Quality
Most printers support a number of different print quality choices. Click on the Print Quality list box to make
your selection. Generally, a low resolution or low quality setting will result in faster printing times - useful 
for printing a quick rough draft or very large projects that will be viewed from a distance. A high resolution 
or high quality setting will give you the best output, but will probably take longer to print - use high quality 
for your final printout.



Output Size

PrintMaster Gold lets you take any project and print it in any size, from as small as a postage stamp to as 
large as a garage door. To select the output size of your project, proceed as follows:

Click the Output Size button in the print dialog. The Custom Print Size dialog will appear.

Enter the desired output size into the dialog fields. A project whose output size is larger than a single 
sheet of paper will be printed on multiple sheets - each sheet is called a tile. As you select the output size,
click the Show button to display a preview of the tile pattern making up the final printout. When your 
project has finished printing, assemble the tiles to create the final printout.

There are five items you can change in the Custom Print Size dialog. Note that all sizes must be 
proportional to the printer paper size. If you change the height, then the width is automatically adjusted 
and vice versa.

Inches Wide specifies the output width in inches.

Inches Tall specifies the output height in inches.

Sheets Wide specifies the output width in multiples of sheets of paper. (Most commonly used to print 
posters or banners.)



Sheets Tall specifies the output height in multiples of sheets of paper. (Most commonly used to print 
posters or banners.)

Scale specifies a percentage scaling factor of printer paper size.

Note: The output size is reset to 100% after each printout.



Which Tiles
For small printouts that fit onto a single tile (sheet of paper), this option is disabled. For large printouts 
(See Output Size) that require multiple tiles, use this option to individually select the tiles to be printed. 

Click on a tile to select it. Click on a selected tile to deselect it.

Turn All On to select all tiles.
Turn All Off to deselect all tiles.

Note: The selected tiles item is reset to "all tiles" after each printout.



Smoothing
Use the smoothing option to soften the roughness of low resolution bitmapped graphics on your printouts.

To turn smoothing on and off, simply click in the check box next to the word Smoothing.

In general, only pictures in bitmapped graphics formats such as TIF or PCX are effected by the smoothing
option. Smoothing has no effect on the pictures provided by PrintMaster and the Mindscape Clip Art 
Library, or any other picture in the CGM graphics format.



Advanced
Click the Advanced... button to display the Advanced Settings dialog.

Use the Outline Picture Contrast slider to adjust the lightness or darkness of printed pictures such as 
CGM and WMF graphics.

Use the Bitmap Picture Contrast slider to adjust the lightness or darkness of printed pictures such as TIF, 
PCX and BMP graphics.



Outline Picture Contrast
Use the Outline Picture Contrast slider to adjust the lightness or darkness of printed pictures such as 
CGM and WMF graphics.

Note: Outline Picture Contrast does not effect text or items such as Calendar lines.

If pictures are printing too dark, adjust the slider to the left, towards the word Light. If pictures are printing 
too light, move the slider to the right, towards the word Dark. A setting of 1000 will cause PrintMaster Gold
to send pictures to the printer without any contrast adjustments.

Dot matrix printers sometimes print too dark. Use the Outline Picture Contrast control to lighten up the 
printout.



Copies
Use this item to select the number of copies you want to print. Simply enter the desired number into the 
box next to the word Copies. The number of copies is reset to 1 after each printout.



Project Size
Use this option to select a page orientation for your new project.

Tall (or Portrait) option prints text across the short width of the paper.

Wide (or Landscape) option prints text across the long width of the paper.



Month and Year...
Use this option to change the Month and Year for your Calendar. You can also use this option to change 
the week for a Weekly Calendar. PrintMaster will automatically number the days for the date you choose.



Calendar Style...
Click the Calendar Style button to access options for customizing your Calendar. 

Change these options to customised the look of your Calendar. Use the Default button to reset all of the 
options to their default values. The available options are described in the following text.

Weekday Names
Use this option to edit the style of weekday names. Three variations of weekday names are offered:

Text only displays only the weekday names.
Box Text displays the weekday names in boxes.
Reversed Text displays the weekday names on a black background.

Weekday Spelling
Use this option to specify the spelling of the weekday names. Three variations are supported:

Initials displays the weekday names as S, M, T, W, T, F, S.
Abbreviations displays the names as Sun, Mon, Tue, Wed, Thu, Fri, Sat.
Full Names displays the weekday names as Sunday, Monday, Tuesday, Wednesday, Thursday, 
Friday, Saturday.

Lines
This option controls what lines are drawn around the Calendar date boxes.

None displays no Calendar lines.
Horizontal displays only horizontal lines.
All lines displays all Calendar lines.

Note: This option does not effect any box drawn around the weekday names.

Line Colour
Select this option to choose the colour for the lines drawn around the Calendar date boxes, the box drawn
around the weekday names, and a colour shadow.

Shadow
This option is used to add a shadow effect to your Calendar.

No shadow turns off any shadow effect.
Black adds a black shadow to the Calendar.
Grey adds a grey shadow to your Calendar.
Light Grey adds a light grey shadow to your Calendar.
100%, 50%, 25% Colour adds a shadow of the chosen Line Colour (see above) to your 
Calendar. The colour is rendered at the selected percentage.

Outline
Select this option to add an outline around the entire calendar.



Edit Calendar Title
Click the Title Text button in the sidebar to edit the contents and style of the Calendar title text. You can 
also edit the title text by clicking on the title text area in the project layout area. See the Calendar Tutorial 
and command reference sections for a complete description of editing text in PrintMaster Gold.



Edit Date Text
Edits the text inside the date box. See the Calendar Tutorial and command reference sections for a 
complete description of editing text in PrintMaster.



Choose Date Picture...
Attaches a picture to the date box. Only a single picture is allowed per date and the picture is always 
sized to fit the box.



Clear Date
Removes any text or pictures in the date box.



Replace Picture...
Select the Replace Picture command to change the image of the selected picture.

Other properties of the selected picture such as the colour, centre position, and flipping are not changed.

1. Select the picture you want to replace (the baseball player). When the picture is properly selected, the
Edit Picture sidebar menu will be displayed.

2. Click the Replace Picture button in the Edit Picture sidebar.

3. Choose a category from the Picture Album by clicking on its tab. To add a new picture to your project 
page, simply double-click on its thumbnail with your mouse.

PrintMaster will return to the Edit Picture sidebar menu. The picture of the baseball player will be replaced
with the basketball player.



View Card
Cards are made up of four separate panels comprising the front, back, and inside surfaces of the card. 
Each panel can have its own background, text, and picture elements. You select the card panel you want 
to work on by clicking the appropriate sidebar button.

Front
Edit the Front panel of your Card.

Inside
Edit the Inside Left & Right panels of your Card.

Back
Edit the Back panel of your Card.



Edit Front
Edit the Front panel of your Card.



Edit Back
Edit the Back panel of your Card.



Building Preview
PrintMaster is building a preview of your project which will allow you to see the project in the open project 
dialog!



Printing...
Relax while PrintMaster Gold prints your masterpiece!



Type in Position
Use this option to type in specific values for positioning or re-sizing your text or picture box.

Left
Specify the number of inches from the left you would like your text or picture.

Top
Specify the number of inches from the top you would like your text or picture.

Width
Specify the number of inches wide you would like your text or picture.

Height
Specify the number of inches tall you would like your text or picture.



Stopping sound playback

Press the sound stop button  to cancel the current playing sounds.



Speaker

This symbol  marks the presence of the Audio Guide.    The controls for the Audio Guide are to the 
right of 

.



Playing sound selections

Press the sound play button  to play sound for the current selection.



Selecting sounds

Press the sound selection button  to obtain the sound selection cursor 

.



Sound Button    
The sound button, located on the tool bar, controls the Audio Guide. Pressing this button results in the 
Audio Guide automatically playing sounds. Release this button to turn automatic playback off. You can 

still play sounds by pressing the play  button.



Sound Preferences
The sound preferences menu allows you to control the PrintMaster Gold Audio Guide.

The 2 selections On & Off,    turn the Audio Guide on and off. The 3rd selection, Always Brief, instructs 
Audio Guide to always use the short version of the sound, ignoring the current Level of Assistance .



PrintMaster Gold Workspace Preferences
The performance of your hard disk is greater than that of your CD-ROM player. The PrintMaster Gold CD 
Publishing Suite uses a hard disk file for some operations thus increasing performance.    This file is called
the workspace file.    



Level of Assistance
Most menus in the PrintMaster Gold CD Publishing Suite have two audio voice tracks, a long version and 
a short version. When you first start using PrintMaster CD you will hear the long version of each voice 
track.    As you gain experience with individual features, Audio Guide will switch over to the short version 
of the voice track. Audio Guide uses the Sound preferences level to determine when you are ready for the
short version of each learned feature.



Sound Preferences Level of Assistance
The Audio Guide Level of Assistance is adjusted with this scroll bar. You may reset the level of assistance 
so a beginner may enjoy full audio instruction from the Audio Guide.



Workspace File
PMW.WRK



Register now for 69 designer fonts and 63 colour graphics

Pat on the nose?

Register Now 



bark bark bark



Software That Works

Mindscape International Ltd.



Congratulations!

    And thank you for choosing the PrintMaster Gold CD Publishing Suite.



Audio Guide

Multi-media ready computer systems with a compatible sound card will 'talk-you-through' the successful 
operation of PrintMaster Gold. This industry exclusive makes PrintMaster Gold the easiest publishing 
product today.



Edit Inside
Edit the inside right and left panels of your card.



Fill-in Fields
A fill-in field is a placeholder that can be filled-in with information from your Address Book or text that you 
type in.

To add a fill-in field, edit a text box and choose Insert Field. Select the field types from the list provide and 
click OK. Next, choose Fill-in Field and type in the desired values. Or, select values from your Address 
Book by clicking the Receiver... button.



Project Album
PrintMaster Gold makes it easy to open projects by letting you select them from an on screen album. The 
Project Album displays a thumbnail of each available project. Simply click on the preview with your mouse
to select a project, and then click the Open button.

Select a project by clicking on its thumbnail preview with your mouse. Click the Open button to begin a 
project.

Displayed down the right side of the Project Album are the Project Category tabs. To select a project 
category simply click on its tab.

A larger sample of each project can be viewed by selecting the Big Previews item located just below the 
Project Album. To return to the standard preview mode click the Big Preview item again.



Thumbnails
A small preview of a document or picture.



Register Now!

CUSTOMER SUPPORT - FREE!    Access to unlimited customer support.

NEW PRODUCT INFORMATION - FREE!    Advanced notice of new products, typefaces and upgrades.

69 ADDITIONAL FONTS & 63 ADDITIONAL GRAPHICS - FREE!



Album Preferences
Use this option to enable (or disable) the Project Album or Picture Album feature of PrintMaster Gold.

Project Album          Check this item to enable selecting projects from the Project Album.

Picture Album          Check this item to enable selecting pictures from the Picture Album. 



Keyboard Status

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Undo
Use this command to reverse changes in editing, formatting, and other actions. To reverse multiple 
actions select this item more than once.

To restore changes that have been reversed with Undo, select Redo.

Shortcuts

Toolbar:
Keys: CTRL+Z



Redo
Use this command to redo or repeat the last editing, formatting, or other changes you made in your 
project. To repeat multiple actions select this item more than once.

To reverse changes that have been made using this command, select Undo.

Shortcuts

Toolbar:
Keys: CTRL+Y



Number Per Page
This option allows you to select the number of pictures to be printed per page.

Note that the more pictures you select per page the smaller their output size will be and vise versa.



More Colours...
Use this option for defining your own custom colours.

Use your mouse to select either a predefined colour from the Basic Colours palette or click the Define 
Custom Colours... button to create your own variations.

Click OK to save and apply your custom colour to your project.

The custom colour you define can also be applied to other text, backgrounds, borders, or pictures by 
simply re-selecting the More Colours... option.



Preferences
This item lets you set Sound (Audio Guide), Workspace, and Album preferences.

For more information, see:

Sound Preferences 
Workspace Preferences 
Album Preferences 



Format Bar
The Format Bar is displayed across the top of the PrintMaster Gold window (just below the Toolbar) and 
provides quick mouse access to some of the most common text and picture editing commands, such as 
Font, Rotate Picture, Position, and Text Alignment.

Note: This item is only available when text or pictures are selected.

To hide or display the Format Bar, click on the Format Bar item located in the View menu.



Address Book
This feature of PrintMaster Gold enables you to merge names, addresses, and other personal information
into your projects from a user-defined Address Book.

The Address Book dialog box is organized into four separate sections, as represented by the four tabs 
located across the top of the dialog:

The Name and Address and Other Information sections are used to enter personal information for entire 
groups of people.

The Overview section is a convenient way to view the personal information for entire groups of people.

The Select Receivers section is used to indicate which persons are included in any printing project.

Note: This feature is available in PrintMaster Suite only.



Name and Address
Use this dialog to enter basic information for each person your adding to your Address Book.

To edit a field, simply click on the field with your mouse and begin typing in the desired data. To quickly 
navigate to other fields, hold down the ALT and type in the letter that corresponds to the underlined letter 
of each field. For example press ALT+T to go to the Title field.

You can also use TAB and SHIFT+TAB to navigate to the next field or backup to a prior field.

See also Other Information and Select Receivers



Picture Field
Pictures can be added to this Address Book field from the hard disk, a floppy disk, or they can be pasted 
from the Windows Clipboard.



Overview
Use this dialog to display the Name and Address and Other Information sections of your Address Book in 
a table format.

To edit a field, simply click on the field with your mouse and begin typing in the desired data. Use TAB and
SHIFT+TAB to navigate to the next field or backup to a prior field.

The horizontal and vertical scroll bars provide access other fields with in the table.

See also Select Receivers



Select Receivers
Use this dialog to select the Address Book entries (see Name and Address) to be printed in your 
PrintMaster Gold projects.

To add an entry to be printed, choose the desired name on the Available Address Book Names list with 
your mouse and then click the Select button to add the entry to the Current Receivers list.

Receiver entries are then added to your project by using Fill-in Fields.



Other Information
Use this dialog to enter additional information for each person in your Address Book.

To edit a field, simply click on the field with your mouse and begin typing in the desired data. To quickly 
navigate to other fields, hold down the ALT and type in the letter that corresponds to the underlined letter 
of each field.

You can also use TAB and SHIFT+TAB to navigate to the next field or backup to a prior field.

The Picture field enables you to associate a scanned image with each Address Book entry.

See also Name and Address.



Zoom In
Use this command to view your project in greater detail.

Choose Zoom In from the View menu. To view your project even closer, select Zoom In again.

or

Click the magnifying glass pointer located on the Toolbar, position it above the area of focus, and click the
left mouse button. Repeat these steps to view your project even closer.

Shortcuts

Toolbar:  

See also Zoom Out and Zoom to Area



Style
Some decorative fonts (e.g., Burlesque, Opera, Showtime) do not have a Bold or Italic variation and 
cannot be altered with this feature.



Patterns
Some Patterns (e.g., White, 2% Grey, etc.) are more effective when accompanied by an Outline or a 
Shadow.



Save Picture Files in Project
This feature embeds a copy of any picture file used in your project within the document itself, so that the 
original picture file is not required the next time you open up the project.

It is particularly useful when you are using pictures that come from a floppy disk or CD-ROM. When used,
PrintMaster Gold will not require the insertion of the floppy disk or CD-ROM containing the picture each 
time the project is opened.



Zoom Out
Use this command to increase the view area.

Choose Zoom Out from the View menu. To increase the view area even more, select Zoom Out again.

or

While holding down the SHIFT key, click the magnifying glass pointer located on the Toolbar. Position it 
above the area of focus, and click the left mouse button. Repeat these steps to zoom out even farther.

Shortcuts

Toolbar:  

See also Zoom In and Zoom to Area



Zoom to Area
Use this command to view a specific area of your project in greater detail.

Choose Zoom to Area from the View menu.

Position the magnifying glass pointer to the left and above the area of focus and hold down the left mouse
button.

Drag the magnifying glass pointer across and down until the desired area is outlined in a box, and then 
release the mouse button.

Shortcuts

Toolbar:  

See also Zoom In and Zoom Out



Calendar Type
Monthly calendars show a full month of days.

Weekly calendars show a single week.

Generic calendars are weekly calendars without specific date numbers.



Picture Album
PrintMaster Gold makes it easy to choose pictures by letting you select them from an on screen album. 
The Picture Album displays a thumbnail of each available picture with the picture file name listed below.

Select a picture by clicking on its thumbnail preview with your mouse. Click the Open button to add the 
picture to your project.

Displayed down the right side of the Picture Album are the Picture Category tabs. To select a picture 
category simply click on its tab.

A larger sample of each picture can be viewed by selecting the Big Previews item located just below the 
Picture Album. To return to the standard preview mode click the Big Preview item again.



Picture Handles
Handles are used to size, position, or rotate a picture by clicking and dragging with your mouse.



Add a New Shape
Use this command to add a Shape to your project page.

To add a new Shape, click the Select Pictures... button in the Design Choices sidebar to bring up the 
Select Picture dialog box.

Click Add a New Shape at the bottom of the dialog box to access the list of available shapes.

See also Picture Rotation 

Shortcuts

Toolbar:  



Add a New Title Text Box
Use this command to add a new Title Text Box to your project.

Note: Unlike standard text boxes, Title Text Boxes can be rotated.

To add a new Title Text box, click the Select Text... button in the Design Choices sidebar to bring up the 
Select Text dialog box.

Click Add a New Title Text Box at the bottom of the dialog box to create an empty text box in your 
project layout area.

Type in your text in the box provided. Use the format bar located just above the text area to change the 
font type and style, or to adjust text alignment.

Note: For best results, it is recommended that you create Title Text Boxes using large font sizes.

To select a shape for your text click the tab labeled: Shape located at the top of the Title Text dialog box.

To apply text and background effects to your Title text, click the tab labeled: Effects.

See also Title Text Rotation

Shortcuts

Toolbar:  



Shapes
In PrintMaster Gold, Shapes are simply described as squares, circles, lines, and other geometric objects 
which you can add to your project pages. Shapes can be rotated by 360 degrees, stretched and sized, or 
customised with a wide variety of colours and outlines.

See also Add a New Shape



Bitmap Picture Contrast
Use the Bitmap Picture Contrast slider to adjust the lightness or darkness of printed pictures such TIF, 
PCX and BMP graphics.

Note: Bitmap Picture Contrast does not effect text or items such as Calendar lines.

If pictures are printing too dark, adjust the slider to the left, towards the word Light. If pictures are printing 
too light, move the slider to the right, towards the word Dark. A setting of 1000 will cause PrintMaster Gold
to send pictures to the printer without any contrast adjustments.

Dot matrix printers sometimes print too dark. Use the Bitmap Picture Contrast control to lighten up the 
printout.



Title Text Box
Another text feature of PrintMaster Gold is the Title Text Box. These specialized text boxes enable you to 
create lines of text that can be "poured" into your choice of shapes, rotated by 360 degrees, stretched and
sized, or customised with a wide variety of colours and outlines. Use Title Text Boxes in your projects 
when you need attention-getting headlines.

See Add a New Title Text Box



Title Text Rotation
You can quickly rotate a Title Text box by click on its rotation handle with the left mouse and, while holding
down the button, drag the handle to the desired location. Release the mouse button when the picture is in
the proper orientation.

Rotation Tip 

Shortcuts

Format Bar:



Title Text Rotation
Hold down the SHIFT key while dragging to restrict the rotation to increments of 45 degrees.



Picture/Shape Rotation
Hold down the SHIFT key while dragging to restrict the rotation to increments of 45 degrees.



Insert Field
Use this command to add Fill-in Fields to your project.

Edit a text box by choosing Type and Edit Text. Select Insert Field and choose a field type from the list 
provided. The chosen field type will then be added to the text box. To apply values to the selected fields, 
select Fill-in Field.

Add allows you to create your own custom Fill-in Fields to add to your Insert Field list.

Rename enables you to rename a custom Fill-in Field created using Add.

Remove deletes the selected Fill-in Field created using Add.

See also Address Book



Picture Rotation
You can quickly rotate a Picture by click on its rotation handle with the left mouse and, while holding down
the button, drag the handle to the desired location. Release the mouse button when the picture is in the 
proper orientation.

Note: Only CGM pictures and Shapes can be rotated.

Picture Rotation Tip

Shortcuts

Format Bar:  



Open From Disk
Use this command to open projects from another hard drive or a floppy disk.

To open a project from another location, pull down the File menu and select the Open From Disk.. 
option.

Choose the project location by selecting the drive and directory. Select a project by clicking on its name in
the File Name list - a preview of the highlighted project will appear to the right.

Click the Open button to open the selected project.



Thumbnail View
Thumbnails are small previews of a document or picture. Use this option to set the Project Album or 
Picture Album to display smaller samples of each project or picture.

A larger sample of a picture can be viewed by selecting File, Picture from above the Picture Album. To 
return to the standard preview mode select this item again.



Project View
A larger sample of a project can be viewed by selecting File, Project from above the Project Album. To 
return to the standard preview mode select this item again.



Open Project
Use this command to open the currently selected project.



Remove Project
Use this command to delete the currently selected project from the Project Album.

Check the Delete project file from disk item if you wish to delete the project file from your hard disk. If 
you only wish to remove the project from the Project Album, clear the check box by clicking on it with your
mouse.



Envelope Feed
Use this item to indicate the position of your envelope as it is inserted into the paper tray.

Tall/Wide indicates which edge of the envelope is fed first into the printer.

Left/Centre/Right indicates the positioning of the envelope along the paper feed path.

Flap Up/Flap Down indicates which way the envelope flap faces when it is fed into the printer.

Rotated changes the orientation of the envelope feed by 180 degrees.



Starting Label
Use this item to specify the starting label on any printout. This feature is useful when printing to a page 
containing only a partial number of labels. On printouts consisting of multiple pages, this feature will only 
apply to the first page. Any additional pages will start printing on the first label.



Sender Name and Address
Use this dialog to enter your own personal information to your Address Book.

To edit a field, simply click on the field with your mouse and begin typing in the desired data. To quickly 
navigate to other fields, hold down the ALT and type in the letter that corresponds to the underlined letter 
of each field. For example press ALT+T to go to the Title field.

You can also use TAB and SHIFT+TAB to navigate to the next field or backup to a prior field.

See also Sender Other Information 



Sender Other Information
Use this dialog to enter additional personal information to your Address Book.

To edit a field, simply click on the field with your mouse and begin typing in the desired data. To quickly 
navigate to other fields, hold down the ALT and type in the letter that corresponds to the underlined letter 
of each field.

You can also use TAB and SHIFT+TAB to navigate to the next field or backup to a prior field.

The Picture field enables you to associate a scanned image with each Address Book entry.

See also Sender Name and Address 



Category Tabs
Displayed down the right sides of both the Project Album and the Picture Album are tabs that represent 
the available Project and Picture categories. To select a category simply click on its tab with your mouse. 

To select a project or picture, simply click on its thumbnail preview. Next, click the Open button.



Back page
Click this button on the Project Album or Picture Album to return to a prior page within the current 
category.

Note: If no additional pages are available within the current category, this item will then move you to a 
prior listed category.



Next page
Click this button on the Project Album or Picture Album to move to the next page within the current 
category.

Note: If no additional pages are available within the current category, this item will then move you to the 
next listed category.



More up
Click this tab on the Project Album or Picture Album to view the prior listed categories.

See also Category Tabs



More down
Click this tab on the Project Album or Picture Album to view additional categories.

See also Category Tabs



Create Your Own Project
Click this button to create your own custom project.



Print Alignment
Use this command to adjust the alignment of your projects on the printed page. This feature should only 
be used if your projects do not print properly aligned.

Click the Print Test Page button to send a test page to your printer.

Use a ruler to measure the printed guide lines and type in the correct value(s) in the space provided.

To return your print alignment back to the original values, click the Reset button.



Layout Preview
This screen displays a sample of the project page as it would appear using the current layout options.



Project Fold
Use this option to select the location of the card fold for your new project.

Side places the fold on the left edge of the card.

Top places the fold at the top edge of the card.



Label Type
Use the item to select the type of Avery Labels to be created.

Select Laser Labels if you are going to be printing to a laser printer.

Select Dot Matrix if you are going to be printing to a dot matrix printer.

From the list provided, highlight the specific Avery Label type and click OK.



Envelope Type
Use the item to select the type of envelope to be created.

From the list provided, highlight the specific envelope type and click OK.



Creating a Business Card

Beginning a Business Card:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Business Card:

Click the Make Your Own Business Card button. Select either Tall or Wide for the Business Card Size.

To open an existing Business Card: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Business Card selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Business Card projects. Choose a design element by 
clicking on the corresponding sidebar button. After confirming your selection, the sidebar will display all of 
the options for editing the background, text, or picture design element you selected.

Note: This feature is available in PrintMaster Suite only.



Creating a Certificate

Beginning a Certificate:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Certificate:

Click the Make Your Own Certificate button. Select either Tall or Wide for the Certificate Size.

To open an existing Certificate: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Certificate selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Certificate projects. Choose a design element by clicking on 
the corresponding sidebar button. After confirming your selection, the sidebar will display all of the options
for editing the background, text, or picture design element you selected.



Creating an Envelope

Beginning an Envelope:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Envelope:

Click the Make Your Own Envelope button. 

Next, select the Envelope Type from the list provided.

To open an existing Envelope: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Envelope selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Envelope projects. Choose a design element by clicking on 
the corresponding sidebar button. After confirming your selection, the sidebar will display all of the options
for editing the background, text, or picture design element you selected.

Note: This feature is available in PrintMaster Suite only.



Creating a Fax Cover

Beginning a Fax Cover:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Fax Cover:

Click the Make Your Own Fax Cover button. Select either Tall or Wide for the Fax Cover Size.

To open an existing Fax Cover: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Fax Cover selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Fax Cover projects. Choose a design element by clicking on 
the corresponding sidebar button. After confirming your selection, the sidebar will display all of the options
for editing the background, text, or picture design element you selected.

Note: This feature is available in PrintMaster Suite only.



Creating a Label

Beginning a Label:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Label:

Click the Make Your Own Label button. 

Next, select the Label Type from the list provided.

To open an existing Label: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Label selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Label projects. Choose a design element by clicking on the 
corresponding sidebar button. After confirming your selection, the sidebar will display all of the options for 
editing the background, text, or picture design element you selected.

Note: This feature is available in PrintMaster Suite only.



Creating a Letterhead

Beginning a Letterhead:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Letterhead:

Click the Make Your Own Letterhead button. Select either Tall or Wide for the Letterhead Size.

To open an existing Letterhead: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Letterhead selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Letterhead projects. Choose a design element by clicking on
the corresponding sidebar button. After confirming your selection, the sidebar will display all of the options
for editing the background, text, or picture design element you selected.

Note: This feature is available in PrintMaster Suite only.



Creating a Note Card
Beginning a Note Card:

Select a project type (e.g., Poster, Card, Banner, etc.) by clicking on its tab as displayed on the Project 
Album.

To create a new Card:

Click the Make Your Own Note Card  button. Select either Tall or Wide for the Note Card Size. Next, 
choose the position of the Note Card fold, pick either Top or Side.

To open an existing Card: 

You can also open an existing project by clicking on the project thumbnail or by choosing File, Open. Click
the Open button to open the current Note Card selection.

The Design Choices menu provides a list of the design elements and commands you can work with to 
create, print, and save your own customised Note Card projects. Choose a design element by clicking on 
the corresponding sidebar button. After confirming your selection, the sidebar will display all of the options
for editing the background, text, or picture design element you selected.

Note: This feature is available in PrintMaster Suite only.



Shape Attributes
This command is used to change the attributes of the currently selected shape.

Click the down arrow button on Fill Colour to choose a colour to apply from a predefined palette. Choose
More... to pick a colour from the Windows colour dialog or define your own custom colours.

Click the down arrow button on Border (Line) Width to modify the outline thickness of the selected 
shape. Choose More... to create your own custom line width. Use up and down arrows on the Line Width 
dialog to set the width.

The Border (Line) Colour option enables you to change the outline colour of the current shape. Choose 
More... to pick a colour from the Windows colour dialog or define your own custom colours.

The Shadow Colour feature lets you apply a coloured shadow to your shape. Choose More... to pick a 
colour from the Windows colour dialog or define your own custom colours.

See also:

 Add a New Shape
 Colour



Inspect Project
This dialog lists file information about the current selected project.

Project Name shows the selected projects file name.

Project Type displays what type of project is selected (i.e., Poster, Banner, Note Card, etc.).

Full Path Name lists the drive and directory location of the selected project.

Byte Size displays the projects file size in bytes.

Last Modified displays the date and time the project was last changed.



Inspect Picture
This dialog lists file information about the current selected picture.

Picture Name shows the selected pictures file name.

Full Path Name lists the drive and directory location of the selected picture.

Byte Size displays the pictures file size in bytes.

Last Modified displays the date and time the picture was last changed.



Rotate
Use this pull down menu to select the degree of rotation for your Title Text, Shape, or Picture. Choose 
either a predefined percentage or type in your own rotation value.

See also:

Title Text Rotation 
Picture Rotation 

Shortcuts

Format Bar:



Starting Card
Use this item to specify the starting business card on any printout. This feature is usefulwhen printing to a 
page containing only a partial number of business cards. On printouts consisting of multiple pages, this 
feature will only apply to the first page. Any additional pages will start printing on the first business card.



Type in Size
Use this option to type in specific values for re-sizing your text or picture box.

1/10, 1/4, 1/3, etc. Page
Specify the size of your text box or picture in relation to the page.

Width
Specify the number of inches wide you would like your text or picture.

Height
Specify the number of inches tall you would like your text or picture.

Scale
Specify the size of your text box or picture by a percentage.



Technical Support

Should you experience any technical problems with this software, such as it failing to operate, please 
contact our Technical Services Department:

Address: Technical Services,
Mindscape International Ltd,
Priority House, Charles Avenue,
Maltings Park, Burgess Hill,
West Sussex, RH15 9TQ, England

Telephone: From inside the UK:
From outside the UK:

01444 239600
(international code) 44 1444 239600

Fax: From inside the UK:
From outside the UK:

01444 248996
(international code) 44 1444 248996

Hours of business: 09:30 to 13:00hrs and 14:00 to 16:30hrs Monday to Friday

We regret that we cannot offer game hints and tips, 
as the service is provided for technical difficulties only.




